NEWTECH INFOSYSTEMS, INC.
Backup NOW!

Backup NOW!
User's Guide
Copyright

The NTI Backup NOW!™ software and the contents of this associated User Manual are the property of NEWTECH INFOSYSTEMS (USA) INC. (NTI) and are protected by copyright. Any reproduction either in whole or in part is strictly prohibited. For additional copies of the software or this documentation, please contact NTI.

Software as well as many other types of works are protected by international copyright laws. Unauthorized copying of those works in any manner may violate the rights of the owner of the copyright in those works and may expose you to civil and criminal penalties.

You may not use NTI Backup NOW! software to violate the copyright rights of others. NTI does not authorize you to use the NTI Backup NOW!™ software for the purpose of violating the copyright rights of others.

Information in this document is subject to change without notice.

Trademarks

NTI Backup NOW!, NTI DVD-Maker, and NTI CD-Maker are registered trademarks of NewTech Infosystems (USA) Inc. NTI CD-Maker Elite, NTI CD-Maker Pro, NTI CD-Maker 2000, NTI CD-Maker MM, NTI FileCD, NTI CD-Copy Tools, NTI CDR Explorer, NTI JewelCase Maker are trademarks of NewTech Infosystems (USA) Inc. Windows is a trademark of Microsoft Corporation. All other product names or trademarks are property of their respective owners.

License

Use of this software constitutes your acceptance of these terms and conditions and your agreement to abide by them. You, the original purchaser, are granted a non-transferable, non-exclusive personal license to use the software. You may neither transfer the software or otherwise make it available to anyone else, nor may you copy, modify, disassemble, decompile, reverse engineer, revise or enhance the software, electronically transfer, or lease the software or this user manual.

You may terminate this agreement at any time by destroying the software. This agreement will Use of this Software constitutes your acceptance of these terms and conditions and also terminate if you fail to comply with the terms and conditions of this agreement. You agree upon such termination to destroy the software.

Limited Warranty

NewTech Infosystems (USA) Inc. warrants for a period of thirty (30) days from the date of delivery that, under normal use and without unauthorized modification, the program performs in substantial compliance with the User Manual and those set forth in NewTech Infosystems (USA) Inc. authorized advertising material; that under normal use, the magnetic or optical media upon which the software is distributed is substantially free from significant defects in materials and workmanship. Warranty claims must be made in writing during the Warranty Period and within seven (7) days of the observation of the defect, accompanied by evidence satisfactory to NewTech Infosystems (USA) Inc. If NewTech Infosystems (USA) Inc. is unable to correct it within ninety (90) days of the date you report the defect, you may return the software and accompanying materials to the NTI distributor from where they were purchased (if not purchased directly from NewTech Infosystems (USA) Inc.) and shall be shipped by the returning party with freight and insurance paid.
EXCEPT AS STATED ABOVE, THERE IS NO OTHER WARRANTY, EXPRESSED OR IMPLIED, REGARDING THE PRODUCT INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Limit Of NewTech Infosystems (USA) Inc. Liability

NewTech Infosystems (USA) Inc. entire liability for damages to you or any other party for any cause whatsoever, whether in contract or in tort, including negligence, shall not exceed the price you paid for the unit of the software that caused the damages or that are the subject matter of, or are directly related to, the cause of action. In no event will NewTech Infosystems (USA) Inc. be liable for any damages caused by your failure to perform your obligations, or for any loss of data, profits, savings, or any other consequential and incidental damages, even if NewTech Infosystems (USA) Inc. has been advised of the possibility of damages, or for any claims by you based on any third-party claim.

Changes

With reasonable efforts have been made in the preparation of this documentation to assure its accuracy, NTI assumes no liability resulting from errors or omissions in this document, or from the use of the information contained herein.

NOTICE

NTI Backup NOW! software is designed to assist you in reproducing material in which you own the copyright or have obtained permission to copy from the copyright owner.

NTI does not authorize you to use the software for the purpose of violating the copyright rights of others. Violating the copyright rights of others may result in severe civil and criminal penalties, and may be prosecuted to the maximum extent possible under the law.

NEWTECH INFOSYSTEMS (USA) INC. takes no responsibility for any illegal use of the product. If you are not sure about your rights, please consult your legal advisor before using NTI software.

Termination

Your failure to comply with the terms in this Agreement shall terminate your license and this Agreement.
Table of Contents

CHAPTER 1 – INTRODUCTION ........................................................................................................ 1

FIRST THINGS FIRST .................................................................................................................... 3

ABOUT THIS GUIDE .................................................................................................................. 3
ABOUT NTI BACKUP NOW! ........................................................................................................ 3
FILE LEVEL AND DRIVE IMAGE BACKUP & RESTORE .......................................................... 4
  Drive Image Backup ............................................................................................................... 4
  File Level Backup .................................................................................................................. 4
Which method of backup do I use? ......................................................................................... 5
SYSTEM REQUIREMENTS .......................................................................................................... 5
A NOTE ON WINDOWS NT AND WINDOWS 2000 .................................................................. 6
INSTALLING BACKUP NOW! ..................................................................................................... 6
REMOVING BACKUP NOW! ....................................................................................................... 7
NTI WEB RESOURCES .............................................................................................................. 7
  Company or Product News and Information ....................................................................... 7
  Frequently Asked Questions (FAQs) ..................................................................................... 7
  Updating your Backup NOW! Software ................................................................................ 7
  Contacting Technical Support ............................................................................................... 8

CHAPTER 2 – USING BACKUP NOW! ..................................................................................... 9

GETTING STARTED ................................................................................................................... 11

GETTING FAMILIAR WITH BACKUP NOW! .............................................................................. 11
  Step Interface ....................................................................................................................... 11
SELECTING FILES IN BACKUP NOW! ..................................................................................... 11
USING MY CATALOG ................................................................................................................. 12

CREATING A BACKUP JOB ..................................................................................................... 13

RESTORING FILES FROM A PREVIOUS BACKUP .................................................................. 14
  Restoring files using Find Files ........................................................................................... 14

COMPARING BACKUP FILES .................................................................................................. 15

DRIVE IMAGE BACKUP AND RESTORE ................................................................................. 16

CREATING A DRIVE IMAGE BACKUP ..................................................................................... 16
RESTORING FROM A DRIVE IMAGE BACKUP ......................................................................... 17

CHAPTER 3 – BACKUP NOW! SCHEDULER ..................................................................... 19

WHAT IS THE BACKUP NOW! SCHEDULER? ....................................................................... 21

USING THE SCHEDULER ......................................................................................................... 21
Introduction
Chapter 1—Topics of discussion

First Things First
   About This Guide
   About Backup NOW!
File Level & Drive Image Backup & Restore
System Requirements
A Note On Windows NT and Windows 2000
Installing Backup NOW!
Updating your Backup NOW! Software
Contacting Technical Support
First Things First

About This Guide
This User’s Guide is unified, in that Windows 95/98/Me and Windows NT/2000 share common information. In each section, and as required, notes have been included where there are particulars pertaining to Windows NT/2000 operation, performance, or use.

About NTI Backup NOW!
NTI Backup NOW! is a backup program for use with the CD-Recordable (CD-R) or CD-ReWritable (CD-RW) drives. It is a powerful, yet simple, program to effortlessly create scheduled backups of your crucial data to a CD-R or CD-RW disc, without requiring the hours of learning that other backup solutions usually entail.

Backup NOW!’s intuitive user interface allows you to instantly navigate your way around your computer to locate files easily. The familiar Windows interface makes backing up your valuable data easy. Our all-new user interface has never been easier. All operations are accomplished in very simple steps. Each step is clearly identified by Backup NOW!.

Backing up or restoring your files is a simple three-step process. Step one–Tell Backup NOW! what files to backup/restore. Step two–Tell Backup NOW! where to backup or restore the data and Step three–Tell Backup NOW! how you want the data backed up or restored.

NTI Backup NOW! offers the following advantages, making it the best and easiest solution for backing up your valuable data:

- Utilizes three different compression levels.
- Supports both file level and drive level (partition level) backup and restore.
- Backup up data from any drive source connected to your computer.
- User selectable file level backup and restore.
- Supports incremental and differential backups.
- Backup or Restore across multiple discs. (Media Spanning)
- Run backup jobs instantly or schedule them for later execution.
- Schedule backup jobs once or repetitively, on a daily, weekly or monthly basis.
- Create bootable Recovery CD or Diskettes.
- Append backup data or overwrite existing data on CD-RW devices.
- Exclude specific file types from file level backups.
- Backup and restore Windows Registry.
- Full backup and restore reporting.
- Time sensitive file replacements on restore operations.
- Restore data to alternate locations.
**INTRODUCTION**

**File Level and Drive Image Backup & Restore**

NTI’s Backup NOW! offers you the rare combination of choosing either file level or drive image (partition level) backup and restore operations from a single backup program. Your important data can be backed up to a local CD-R or CD-RW device. Your backup data can be written to a single CD-R/CD-RW disc or span across several discs as necessary. Backup NOW! supports three levels of compression to reduce the space requirements of a backup image.

The following sections explain the capabilities and limitations of each backup method as well as when you need to use each one.

**Drive Image Backup**

Drive Image backups create an exact copy of the drive being backed up. Backup NOW! bypasses the file system and copies all data directly from the hard drive. You can backup any drive that is installed on your computer system using drive image backups. They can be saved on any CD-R or CD-RW Recorder on your computer or any hard disk installed or connected to your system, including network hard disk.

Drive Image backups are quick and easy. You simply select the source drive, compression level and the destination drive and away you go! At the click of a button, Backup NOW! creates an image of the selected source drive.

Restoring a drive using a drive image is just as easy. It is important to remember however, that a drive image backup is a snapshot of the source drive at a particular moment in time. Restoring from this type of backup image is an all or nothing event. The destination drive will be restored exactly as it was when the backup image was created. All changes to that drive made after the time that the backup image was created will not be restored!

Since drive image backups are complete copies of the actual disk partition or hard drive and work directly with the physical device, it is not possible to selectively restore specific files or folders to your system. You must use Backup NOW!’s file level backup when you need to replace specific files or folders.

**File Level Backup**

File level backups are the most flexible way of backing up your important data to a locally installed CD-R/CD-RW device. You can selectively backup files and restore files, exclude specific file types such as hidden or system files and backup and restore the Windows Registry file using the file level backups.

Source files can be located on any storage device installed on or attached to your computer system. File level backup jobs can be executed now or scheduled to run later or even on a periodic basis using the Backup NOW! Scheduler. The job files themselves can also be saved for later use or modification. Incremental and differential backups are fully supported using Backup NOW!’s file level backup.
Which method of backup do I use?
As mentioned earlier, Backup NOW!’s drive image backups are all or nothing events, they bypass the file system, backups are from a single hard disk drive (or partition) that must be physically installed on your computer, they can be saved to any attached hard disk or a CD-R or CD-RW device installed on your computer and they are executed instantly, not a backup job that can be scheduled for a later date. Use the table below to determine which backup method to use for a given situation.

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Drive Image</th>
<th>File Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup your data to a disk file?</td>
<td>✓</td>
<td>□</td>
</tr>
<tr>
<td>Make an exact duplicate of your source drive?</td>
<td>✓</td>
<td>□</td>
</tr>
<tr>
<td>Restore backed up data to an alternative location?</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Backup/Restore the Windows Registry file?</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Backup or Restore specific files or folders?</td>
<td>□</td>
<td>✓</td>
</tr>
<tr>
<td>Incremental or Differential backups?</td>
<td>□</td>
<td>✓</td>
</tr>
<tr>
<td>Schedule the backup for a specific time or date?</td>
<td>□</td>
<td>✓</td>
</tr>
<tr>
<td>Execute backups automatically on a daily, weekly or monthly basis?</td>
<td>□</td>
<td>✓</td>
</tr>
<tr>
<td>Backup up and restore a network drive?</td>
<td>□</td>
<td>✓</td>
</tr>
<tr>
<td>Backup and restore data from multiple drives to a single backup image?</td>
<td>□</td>
<td>✓</td>
</tr>
<tr>
<td>Exclude specific file types from your backup?</td>
<td>□</td>
<td>✓</td>
</tr>
<tr>
<td>Backup a storage device that isn’t a hard disk?</td>
<td>□</td>
<td>✓</td>
</tr>
<tr>
<td>Restore a file only if the copy on the backup is newer?</td>
<td>□</td>
<td>✓</td>
</tr>
</tbody>
</table>

System Requirements
It is important that your system meet the above requirements. If you have questions, please contact NTI for further information. Please check the following system requirements before installing Backup NOW!.

**Hardware Requirements**

IBM PC or compatibles Pentium 90 or higher

Minimum 32 MB Main Memory. (64MB Recommended) Windows NT and Windows 2000 Operating Systems may require at least 64 MB of Main Memory.

NTI-supported CD recorders. Please visit our web site at [http://www.ntius.com/CertifiedCDRdrives.htm](http://www.ntius.com/CertifiedCDRdrives.htm) for the latest list of NTI-supported CD recorders.

**Software Requirements**

Microsoft Windows 95/98/Me, 2000 Professional or Windows NT 4.0 Workstation (Service Pack 6)
INTRODUCTION

A Note on Windows NT and Windows 2000
Windows NT and Windows 2000 have implemented file access restrictions and other security features that may prevent user access to certain system resources such as the registry. For this reason, we strongly recommend that you log on as Administrator (or a member of the Administrator’s group), before using NTI Backup NOW! for your backup and restore operations.

Installing Backup NOW!
To install NTI Backup NOW! you will need approximately 15 MB of free hard disk space. An automated SETUP program is provided to guide you through the installation. The default target directory (the directory where NTI Backup NOW! resides), is “C:\Program Files\NewTech Infosystems\NTI Backup NOW!”. The setup program will walk you through the installation process.

To install Backup NOW!:

1. Insert the Backup NOW! CD into the appropriate drive.
2. An install screen is displayed automatically by Windows. If you do not see this screen then click Run from the Start button on the Taskbar and in the dialog box type:

   D:\BKUPNOW!\language\setup.exe

Notes:

   Where "D" is the drive letter of the CD-ROM drive which the Backup NOW! CD is inserted. The drive letter may be different depending on your system configuration.

   Where “language” is the language you would like to have the software installed (Chinese, English, French, German, Italian, Japanese, Korean, or Spanish). You can browse the BackupNOW! folder to see which languages are currently available. Each language is in its own folder.

3. Click OK to execute the Setup program.
4. On the Welcome panel, click on the Next button.
5. Read the END-USER LICENSE AGREEMENT FOR NTI SOFTWARE and click the Yes button if you accept the terms of the license agreement and wish to continue with the installation of the Backup NOW! software.
6. Enter your user information and the product serial number (if required) and click Next.
7. Select the installation directory from the Choose Destination Location dialog and click the Next button. Click the Browse button to select a different installation directory if desired.
8. Enter the Program Folder where the Backup NOW! icons will be added and click Next.
9. NTI Backup NOW! will now be installed in the target directory. Backup NOW! program group with the appropriate shortcuts will be added to the Start menu.
10. You will be asked to restart your computer. The Setup Complete dialog will let you reboot now or later. It is recommended to select the "Yes, I want to restart my computer now." option and Click the Finish button and reboot your computer.
Removing Backup NOW!
You can remove the Backup NOW! software from your system from the Windows Add/Remove Programs utility.

⚠️ To uninstall the Backup NOW! software:
1. Run the Control Panel application from the Start -> Settings menu.
2. Double-click the Add/Remove Programs icon.
3. From the Install/Uninstall Tab, select NTI Backup NOW! from the list of programs installed on your computer.
4. Click Add/Remove…
5. Click Yes to confirm the removal operation.

NTI Web Resources
NTI is committed to your success! We hope to make your experience with Backup NOW! the best possible by making available news and information, product updates and upgrades, Frequently Asked Questions and our Technical Support from the Internet. Our web site is at http://www.ntius.com.

Company or Product News and Information
Find out the latest about NTI what we are doing at http://www.ntius.com/corporate/ithenews.htm or any of our world-class products at http://www.ntius.com/products/index.htm. Learn about the latest features or supported drives for Backup NOW! You can even download a trial version of any of our products directly from our web site giving you the easiest way to give our software a test drive before you buy.

Frequently Asked Questions (FAQs)
You can browse the latest information and commonly asked questions about Backup NOW! from our web site at http://www.ntius.com/faq.htm. Find out what questions other Backup NOW! users had about it. Get quick answers to the most commonly asked questions.

Updating your Backup NOW! Software
From time to time, we release product updates and upgrades from our web site. Product updates generally contain patches and other corrections to the Backup NOW! software and are available for registered users to download for free. Upgrades involve major product enhancements along with patches to reported problems. They will also be available for download but may involve a nominal fee.

Updates can be installed by executing the downloaded file. All updated files and patches will be applied to your Backup NOW! software automatically! It is highly recommended that you download and install any updates prior to contacting our Technical Support Department.

Visit our web site at http://www.ntius.com/download/index.cfm for the latest updates for all NTI products!
INTRODUCTION

Contacting Technical Support
Many different types of on-line help are available with NTI Backup NOW! within the specified applications. You can browse through the NTI Backup NOW! Help file to become familiar with all the features available within that application.

You can also use context-sensitive help to display information about specific commands, dialog boxes, and other window elements.

If you still experience problems using NTI Backup NOW! that this documentation cannot solve, please submit the Technical Problem Report form which can be found on the NTI CD-ROM disc (also available on our web site for download). Help and information on the latest upgrades as well as an NTI Technical Forum on Frequently Asked Questions (FAQs) can be found on our web site.

To request technical support from NTI:

1. If you have questions or technical issues to report to NTI, please COMPLETE and SUBMIT the TECHSUPT.DOC and email it to Support@NTIus.com. Without submission of this form, we regret that we will be unable to respond.

To locate the NTI Software Problem Reporter:

1. Put the NTI software in your CD-R drive
2. Click on My Computer
3. Click on your CD-R/RW drive
4. Click on techsupt.doc or techsupt.txt or techsupt.wri
5. Fill it out and email it to Support@NTIus.com or FAX it to (714) 259-9727

THANK YOU FOR YOUR COOPERATION!
Using Backup NOW!
Chapter 2—Topics of discussion

Getting Started
   Getting familiar with Backup NOW!
   Selecting Files in Backup NOW!
   Using My Catalog

Creating a Backup Job
   Step 1—What to backup?
   Step 2—Where to backup?
   Step 3—How to backup?

Restoring Files from a Previous Backup
   Step 1—What to restore?
   Step 2—Where to restore?
   Step 3—How to restore?

Comparing Backup Files
   Step 1—What to compare?
   Step 2—Where to compare?

Drive Image Backup and Restore
   Creating a Drive Image Backup
   Restoring from a Drive Image Backup
Getting Started

In this Chapter, we will show you how to backup, restore and compare your data with Backup NOW! using File Level backups. We will also show you how to create, save, edit, schedule and execute a backup job with Backup NOW! Disk Image backups are explained at the end of this chapter.

Getting familiar with Backup NOW!

The first thing that you will notice about Backup NOW! is how it automatically customizes itself based on the operation you wish to perform. You can select from the Backup, Restore and Compare operations with the click of a button from the main toolbar. Backup NOW! does the rest.

Step Interface

Backup NOW!’s intuitive Step Interface guides you through the backup, restore and compare process. Step one — Defines the data to be used or “What” data to backup, restore or compare. Step two — Defines the target destination or “Where” to backup, restore or compare the source data. Step three — tells Backup NOW! “How” to backup or restore the selected source data. Backup NOW! splits these into separate steps for ease of use. As you can see above, it is just a simple click of a button and you are on the next step of the process.

Selecting files in Backup NOW!

Backup NOW! uses a Window’s Explorer style view when you need to select specific files or folders for any step of the selected operation. The selection view is split vertically into two panes. The left pane, Resource Tree Pane, displays the system resource tree. The right pane, File Information Pane, displays detailed information about items selected from the system resource tree. Branches or nodes on the tree can be expanded or collapsed by clicking on the + or - to the left of the item or by double clicking on the item itself. The two panes may be resized horizontally by dragging the splitter bar between them. Dragging the splitter bar to the left will display more of the file information pane while reducing the visible portion of the resource tree pane.
USING BACKUP NOW!

The file information pane has four columns that display the file/folder name, its size, the file type and the last modified date. The files may be sorted on any one of these columns by clicking on the column header. By default, files are sorted alphabetically (ascending) by name. Click the Name column heading to sort them in descending order by name. Items listed in the file information pane may include a small checkbox to the left of their name indicating that they can be selected within Backup NOW! Simply click the box to include that item and all items below it in the file structure in the current operation. For example, if you check the box to the left of the C: drive icon, all files and folders on your C drive will be selected automatically. If you expand the C drive from the resource tree and then check the box to the left of the Autoexec.bat file then only the Autoexec.bat file is selected for the current backup, restore or compare operation.

To Select a file/folder:
1. Navigate the resource tree to locate the desired file, folder or drive.
2. Check on the box to the left of the desired item.

To Deselect a file/folder:
1. Navigate the resource tree to locate the desired file, folder or drive.
2. Uncheck on the box to the left of the desired item.

Using My Catalog

BackupNOW! logs information about every backup executed in to a file called My Catalog. All restore and compare operations allow you to select from My Catalog or the actual backup files stored on CD-ROM discs. The advantage of using My Catalog is that you can search for specific files from all catalogs on your system. You won’t have to swap CDs in and out to find the right file. Catalogs are saved in the Catalog folder in the Backup NOW! directory. Catalog files require additional disk space and over time, it can add up. You can view catalog entries from My Catalog using the File Catalog dialog box.

To remove one or more catalog entries from My Catalog:
1. In either Restore or Compare mode, select My Catalog in the From combo box.
2. Select one or more of the catalog entries by checking the box to the left of their name.
3. Click Remove to delete the selected catalog entries.
4. Click Close.

To load the resource tree from My Catalog:
1. In either Restore or Compare mode, select My Catalog in the From combo box.
2. Select one or more of the catalog entries by checking the box to the left of their name.
3. Click Load. Backup NOW! loads the Resource Tree Pane with the selected catalog entries.
Creating a Backup Job

File level backups are defined as a job to the Backup NOW! program. You select the backup operation by clicking the backup icon on the main toolbar. Backup jobs can be saved for later use and editing, scheduled for later execution by the Backup NOW! Scheduler or run directly from Backup NOW!

To create a backup job:

Step 1: “What to backup”
1. Click the Step 1 button on the left-hand side of the main window.
2. Select the folders or files you wish to backup. (See Selecting Files in Backup NOW! in this chapter for additional information.)

Step 2: “Where to backup”
1. Click the Step 2 button to select the destination of the backup file.
2. Select the CD-R or CD-RW drive that holds the blank CD-R or CD-RW disc. The backup file will be stored there.
3. Change the filename of the corresponding backup file (XXX.NBF) if desired.

Step 3: “How to backup”
1. Click the Step 3 button to select the type of backup you wish to perform.
2. Select from All selected files or New and changed files only.
3. If you selected New and changed files only, you have to select from either Differential or Incremental options. You may click the Options button for advanced features.

Note:
See Chapter 3: Backup Options, or Backup Options: Type for explanations of the terms.

Once the backup job has been fully defined, you can save it by clicking on the Save button on the toolbar. Remember to set a password on the Password tab of the backup options should you wish to password-protect your backup file. Click the Start button to run the backup job now or the Schedule… to run it at another time using the Backup NOW! Scheduler.

Note:
If you attempt to run or schedule the job before saving you will be prompted to save the job before continuing. A backup job must be saved before it can be used with the Backup NOW! Scheduler. (See Chapter 3 – Backup NOW! Scheduler for information on scheduling a backup job for later execution.)
Restoring Files from a Previous Backup

File level restores can be run from a specific backup image or from My Catalog. You select the restore mode by clicking the restore icon on the main toolbar.

To restore files from a previous backup:

Step 1: “What to restore”
1. Click the Step 1 button on the left-hand side of the main window.
2. Load the Resource Tree from either My Catalog or a specific backup file. (See Using My Catalog in this chapter for additional information.)
3. Select the folders or files you wish to restore.

Step 2: “Where to restore”
1. Click the Step 2 button to select the destination or where you want to restore the backup files.
2. Select the destination of the Restore, at its Original location or select an Alternate location. You can click the folder icon to the left of the alternate location textbox to browse your system for the desired restore location.

Step 3: “How to restore”
1. Click the Step 3 button to select the type of restore you wish to perform.
2. Select a restore option from the list.

Note:
See Chapter 3: Restore Options for additional information about each option.

Once you have selected the files to be restored, simply click on the Start button to start the restore process. If the selected backup file has been password protected, you will be prompted for the password to this backup file.

Restoring files using Find Files
You can search My Catalog or a backup image for a specific file using the Find Files. Are you missing a file that you know you had previously backed up? Locate the file in My Catalog and then restore it from the backup image.

To locate and restore a file with Find Files:
1. Load the Resource Tree from either My Catalog or a specific backup file. (See Using My Catalog in this chapter for additional information.)
2. In Restore mode, select Find Files… item from the Edit Menu.
3. Enter the name of the file you want to search in the “Named:” edit box.

* Note: 

The find files feature supports standard wildcard searches such as *.doc to locate all Word documents in a backup or selected catalog.

4. From the list of found files, select the files you wish to restore.
5. Select the location of the restore, and set the restore options.
6. Click the Start button to start the restore operation.

**Comparing Backup Files**

You can compare original files to the backed up version of that file using the compare operation. File level compares can be run from a specific backup image or the catalog. You select the compare operation by clicking the compare icon on the main toolbar.

* To compare backup files:

* Step 1: “What to compare”

1. Click the Step 1 button on the left-hand side of the main window.
2. Load the Resource Tree from either My Catalog or a specific backup file. (See Using My Catalog in this chapter for additional information.)
3. Select the folders or files you wish to compare.

* Step 2: “Where to compare”

1. Click the Step 2 button to select the destination or where the files are you want to compare with the backup files selected in Step 1.
2. Select the destination of the Compare, at its original location or an alternate location.

Once you have selected the files to be compared, simply click on the Start button to start the compare process.
NTI Backup NOW! Version 2.0 adds the ability to create a backup of a complete drive image to a CD or another hard drive.

**Note:**

On Windows NT and Windows 2000, you must be logged on as Administrator (or a member of the “Administrator” user group) in order to perform Drive Image backup and restore.

### Creating a Drive Image Backup

1. Select Drive Image Backup/Restore… from the Tools Menu. The Drive Image dialog is displayed with the Backup Tab selected.

2. Select the drive you wish to backup from the list. Backup NOW displays all hard drives attached to your system in the “Select a drive to backup:” drop-down list.

3. Choose the desired compression level.

4. Select the destination device from the “Backup to:” list.

5. Enter the filename for the new image backup file.

**Note:**

If you select “CD-R File” from the list then you need to enter the filename for the new image backup as well as select the desired CD Recorder. If you select “Disk File” then you may enter the full path and name of the image backup file or click the browse button. If you enter the name directly be sure to include the .NPF extension with the name.

6. Click Start to begin the drive image backup.
Restoring from a Drive Image Backup

To Restore From a Drive Image Backup File:

1. Select Drive Image Backup/Restore… from the Tools Menu. The Drive Image dialog is displayed with the Backup Tab selected.

2. Click the Restore tab.

3. Enter the filename for the new image backup file.

   **Note:**

   You may enter the full path and name of the image backup file or click the browse button. If you enter the name directly be sure to include the .NPF extension with the name.

4. Select the drive you wish to restore from the list. Backup NOW displays all hard drives attached to your system in the “Select a target drive to restore:” drop-down list.

5. Click Start to begin the drive image restore. The progress bar will indicate the status of the restore operation.
Notes:

- ✩ Restored NTFS partitions cause the chkdsk utility to be run when the system is rebooted to verify their proper operation. Windows NT/2000 will run the verification process and then restart. The restored drive should be fully operational once Windows has restarted.

- ↘ When you select a target drive to restore, you must pay attention to the compatibility of the File Systems (e.g. FAT16, FAT32, or NTFS) between the source Backup File, and the Restore Target Partition. The following table lists all compatible combinations of source and target, and the resulting partition format. Other combinations not on the list will not work.

1. If Drive Image Restore within Win32 application

<table>
<thead>
<tr>
<th>Source Backup File</th>
<th>Restore Target Partition Format</th>
<th>Result Partition Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTFS</td>
<td>NTFS</td>
<td>NTFS</td>
</tr>
<tr>
<td>NTFS</td>
<td>FAT16</td>
<td>NTFS</td>
</tr>
<tr>
<td>NTFS</td>
<td>FAT32</td>
<td>NTFS</td>
</tr>
<tr>
<td>FAT16</td>
<td>FAT16</td>
<td>FAT16</td>
</tr>
<tr>
<td>FAT32</td>
<td>FAT32</td>
<td>FAT32</td>
</tr>
</tbody>
</table>

*Other combinations will not work*

2. In command-line Drive Image Restore

<table>
<thead>
<tr>
<th>Source Backup File</th>
<th>Restore Target Partition Format</th>
<th>Result Partition Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTFS</td>
<td>NTFS</td>
<td>NTFS</td>
</tr>
<tr>
<td>NTFS</td>
<td>FAT16</td>
<td>NTFS</td>
</tr>
<tr>
<td>NTFS</td>
<td>FAT32</td>
<td>NTFS</td>
</tr>
<tr>
<td>NTFS</td>
<td>Non-formatted</td>
<td>NTFS</td>
</tr>
<tr>
<td>FAT16</td>
<td>FAT16</td>
<td>FAT16</td>
</tr>
<tr>
<td>FAT32</td>
<td>FAT32</td>
<td>FAT32</td>
</tr>
</tbody>
</table>

*Other combinations will not work*
Chapter 3

Backup NOW! Scheduler
Chapter 3—Topics of discussion

What is the Backup NOW! Scheduler?
Using the Scheduler

Menu commands for Backup NOW! Scheduler
Program
Advanced
Help
What is the Backup NOW! Scheduler?

Backup NOW! Scheduler is a backup monitoring program, which Backup NOW! uses to manage its scheduled backups. Using the Backup NOW! Scheduler, you may remove, suspend or terminate already scheduled backup jobs. A Backup NOW! Scheduler icon will show up on the System Tray, which resides on the Windows taskbar. To bring up Backup Scheduler, point your mouse to the NTI Backup Scheduler icon on the System Tray, and then right click. Choose Open from the popup menu. You can also double-click on the

Note:
The Scheduler must be running for the scheduled backups to take place.

Using the Scheduler

Using the Schedule function, you may set the date and time you wish to back up your data, then the NTI Backup NOW! will perform unattended backups without user interaction.

To schedule a backup job:

1. Click the Schedule button in any of the Backup windows.
2. The following “Scheduler Setup” dialog box will be displayed:
3. Select either Once, Daily, Weekly, or Monthly radio button from the dialog box.
4. Enter the date and time you wish the NTI Backup NOW! to perform the scheduled backup.
5. Click OK.

Notes:

Note: The NTI Backup Scheduler must be running to be able to execute scheduled backup jobs!

If a backup requires more than one disc, users need to manually change the CD-R or CD-RW media when the first disk is full. Although Backup NOW! supports media spanning, care must be taken to avoid this situation for unattended backups.

All scheduled backup jobs can be viewed from the Backup NOW! Scheduler.
To remove a scheduled backup job:
1. Open the Backup NOW! Scheduler window.
2. Select the backup job to be removed from the scheduler window.
3. Click the Remove item from the Program Menu.
4. Click Yes on the confirmation dialog to remove the selected backup job.

To suspend the Backup NOW! Scheduler:
1. Open the Backup NOW! Scheduler window.
2. Click the Suspend Scheduler item from the Advanced Menu. A small checkmark will be visible to the left of the Suspend Scheduler item when the scheduler has been suspended. No backup jobs will be executed while the scheduler is suspended.

To resume the Backup NOW! Scheduler:
1. Open the Backup NOW! Scheduler window.
2. Click the Suspend Scheduler item from the Advanced Menu. The small checkmark should no longer be visible and scheduler operations are resumed. Scheduled backup jobs will be processed normally.

To terminate the Backup NOW! Scheduler:
1. Open the Backup NOW! Scheduler.
2. Click the Terminate Scheduler item from the Advanced Menu.
3. Click OK on the confirmation dialog to exit the scheduler program. No backup jobs will be executed while the scheduler is not running.

Scheduler Job Logs
The Backup NOW! Scheduler maintains a log for every backup job it monitors. These logs provide status information for each scheduled job.

To view the log for a scheduled backup job:
1. Open the Backup NOW! Scheduler window.
2. Select the backup job whose log you wish to view.
3. Click the View Log item from the Advanced Menu.
Menu Commands for Backup NOW! Scheduler

All NTI Backup NOW! Scheduler menus can be invoked by a single left-button click of a mouse on the menu bar. Menu items are aligned on the left, with keystroke shortcuts (if applicable) displayed on the corresponding right side. The underlined character of a menu item, if pressed (through the keyboard), will have the same effect as if the menu item were selected with the mouse.

**Program**

<table>
<thead>
<tr>
<th>Remove</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
</tr>
</tbody>
</table>

*Remove*

Removes the selected Backup Job from the window.

*Close*

Closes the scheduler window but the program remains running in the background. The system and scheduler must be running to start any scheduled backup job.

**Advanced**

<table>
<thead>
<tr>
<th>Suspend Scheduler</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminate Scheduler</td>
</tr>
<tr>
<td>View Log</td>
</tr>
</tbody>
</table>

*Suspend Scheduler*

Suspends the Scheduler from performing scheduled backups.

*Terminate Scheduler*

Halts the execution of the Backup NOW! Scheduler. The scheduler must be restarted for scheduled backups to be performed.

*Note:*

Backup jobs will not be removed even if the Backup Scheduler is terminated.

*View Log*

Displays the log file for the selected job.

**Help**

<table>
<thead>
<tr>
<th>Help Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>About NTI Backup NOW! Scheduler...</td>
</tr>
</tbody>
</table>

*Help Topics*

Brings up On-line help.

*About Backup NOW! Scheduler*

Displays program information, Version number and copyright.
Advanced Topics
Chapter 4 — Topics of discussion

Backup NOW! Tools & Utilities
  Completion Reports
  Emergency Recovery Diskette and CD
  Erasing a CD-RW Disc
  Comparing Two File Folders
  Backup and Restore Options
  CD Drive Properties
  Backup Format
  Media Spanning
  Choosing a Backup Method

Error Messages
  The Error Log
  Error Messages
Backup NOW! Tools & Utilities

NTI Backup NOW! contains several useful utilities that will help you in better managing your backups, as well as extend the usage of a CD-R or CD-RW media by being able to create a bootable CD. It also includes a CD-RW eraser, which will erase the contents of a CD-RW disc.

Completion Reports

Backup NOW! generates a completion report at the end of every backup, restore or compare operation. These reports can contain a list of all files selected for a given operation and the status of the operation. You will want to view these reports to be sure that an operation was completed successfully. A report may be viewed upon the completion of an operation. All reports are saved in the Backup NOW! Reports folder where they can be viewed later if necessary.

To view a Backup Report:

1. Select the View Backup Reports… item from the View Reports Menu of the Tools Menu.
2. Backup NOW! displays the Backup Report dialog box.
3. Select the report you would like to view from the list of reports.
4. Click View to display the report in Windows’ Notepad or Remove to delete the selected report.
5. Click Close to return to the Backup NOW! window.
To view a Restore Report:

1. Select the View Restore Reports… item from the View Reports Menu of the Tools Menu.
2. Backup NOW! displays the Restore Report dialog box.
3. Select the report you would like to view from the list of reports.
4. Click View to display the report in Windows’ Notepad or Remove to delete the selected report.
5. Click Close to return to the Backup NOW! window.

**Emergency Recovery Diskette and CD**

Backup NOW! Emergency Recovery Wizard will help you create a bootable, emergency recovery diskette or CD for your system. It is always a good idea to create and keep a recovery CD on hand for those unpredictable problems that prevent you from booting from your main hard drive.

Backup NOW! uses your existing Startup diskette to create a recovery diskette or CD. The Windows Startup diskette contains the files required to boot your computer in to DOS and access your CD drive(s). A Recovery Diskette or CD is a slightly modified version of the Startup diskette, adding the ability to automatically recover your files from a previously saved backup image and NTI’s restore command. As you can see, it is necessary to have a backup image containing the Windows system. The Emergency Recovery CD makes an excellent place to keep your full backup image. When combined with Backup NOW!’s Silent Restore facility, recovering your system is easy. The Emergency Recovery Wizard will assist you in the creation of your Recovery CD.
Starting the Emergency Recovery Wizard

To Start the Emergency Recovery Wizard:

1. Select the Recovery Diskette & CD… item from the Tools Menu.
2. Backup NOW! displays the Emergency Recovery Diskette and CD Wizard. The wizard will guide you through the process of creating a Recovery CD & Diskette.

Note:

The page shown above is running under the Windows 98 operating system. The wizard senses the operating system and displays the pages accordingly. This screen may vary slightly or may not be displayed in all circumstances.
Windows 98/Me Recovery Wizard - Start Up Source

From this page you tell the Emergency Recovery Wizard where to find the files necessary to create a bootable recovery Diskette and CD. The wizard senses the operating system and walks you through the process of creating a Recovery CD for your system. You will be required to supply your Windows CD, CAB files or a Startup diskette created for your system. Windows 95 users will need to install and configure drivers allowing access to your CD drive from MS DOS.

To complete this page:

1. Select the floppy drive to be used to create the Recovery Diskette.

2. Select the source for the bootable system files from the “Creating a Bootable Floppy Diskette from” group.

   A. Choose the “Windows CD-ROM” option if you have your Operating System CD or CAB files available. Use the Browse button to locate the requested CAB files.

   B. Choose the “Windows Startup Disk” option if you have a Startup Diskette available.

Note:

- You may click on the Create Startup Disk… button if you need to create a Startup diskette before continuing with the Emergency Recovery Wizard.

3. If you have selected the “Windows CD-ROM” option above, insert a blank, formatted diskette in the drive selected in Step 1 above. This will be used to create a bootable Recovery diskette, which can be used for systems that do not support booting from a CD ROM device.

4. Click Next to continue to the next page.

Notes:

- You may click on the “Create Startup Disk…” button if you need to create a Startup diskette before continuing with the Emergency Recovery Wizard.

- Backup NOW! will read the systems files necessary to create a bootable Recovery Diskette before continuing on to the next page. These files are saved by Backup NOW! for later use.

- Only steps 1, 3 & 4 apply if you have previously created a bootable Recovery CD/Diskette and answered “Yes” to the prompt to use the existing boot files.
Windows 98/Me Recovery Wizard - Select Options
This page selects the options to be performed by the Emergency Recovery Wizard. By Default, the wizard automatically creates a bootable Recovery Diskette. You may choose to create a bootable Recovery CD and to store a drive image backup on that CD for recovery purposes. You will be required to supply a blank piece of CD-R or CD-RW media if you want to create a Recovery CD/backup.

To complete this page:
1. Check the desired options. By default, the wizard is configured to create an Emergency Recovery CD and save a drive image backup to the same disc.
2. Select the target CD-R/RW drive for the Recovery CD if necessary.
3. Insert a blank piece of CD-R/RW media in the selected drive.
4. Click Next to continue to the next page.

Note:
- You may click on the “Erase” button if you want to erase the CD-RW media in the target drive.

Windows 98/Me Recovery Wizard - Select Backup Source
This page selects the drive to be backed up by the Emergency Recovery Wizard. Normally, this would be the drive with the operating system on it. This is the image that will be restored when you boot from your Emergency Recovery CD/Diskette. You may also specify a name for your backup image from this page.

To complete this page:
1. Select the drive to be backed up from the drive list. Only drives that are installed on your computer will be listed.
2. You may click the “Options…” button to change the compression settings or add password protection to your Recovery CD.
3. Enter a name for your backup image file. The boot files will be configured to restore the image with this name. It must comply with the DOS 8+3 file naming convention. In most cases, it is neither necessary nor recommended to change the default name.
4. Click Next to create the Recovery CD/Diskette.

Note:
- If you used a Startup diskette on Page 1 of this wizard please remove the Startup diskette and insert a blank, formatted diskette if the floppy drive before continuing (clicking the Next button) with the Emergency Recovery Wizard.
ADVANCED TOPICS

Windows 98/Me Recovery Wizard - In Progress
This page displays the progress of each of the steps during the creation of the Recovery CD/Diskette.

To complete this page:
1. Click the View Report button to see the results of the backup operation or click Finish to exit the wizard.

Windows 95 Recovery Wizard - Start Up Source
This page tells the Emergency Recovery Wizard where to find the files necessary to create a bootable recovery Diskette and CD. You will need to install and configure drivers allowing access to your CD drive from MS DOS.

To complete this page:
1. Select the floppy drive to be used to create the Recovery Diskette.
2. Insert a blank, formatted diskette in the drive selected in Step 1 above. This will be used to create a bootable Recovery diskette that can be used for systems what do not support booting from a CD ROM device.
3. Click Next to continue to the next page.

Windows 95 Recovery Wizard - Driver Configuration
This page tells the Emergency Recovery Wizard how to configure the device drivers to allow access to your CD drive from MS DOS. You must have previously installed and configured the drivers for your CD drive. Consult your User’s Manual for your CD drive for additional information on the installation of these drivers under DOS.

You will also need to be able to identify the drivers for your CD and copy information from your config.sys and autoexec.bat files.

To complete this page:
1. Locate the device driver for CD drive in the config.sys file.
2. Using a text editor such as Windows Notepad, Select and Copy the Device= line from the config.sys file to the clipboard.

Note:
Run notepad from the Start Menu. Enter “notepad.exe c:\config.sys” in the Open box and click OK. Select the Device= line and the copy(Ctrl+C) the highlighted line to the clipboard.
3. Select the sample Device= line from the Wizard page.
4. Click the Edit Button.
5. With the entire line highlighted, paste(Ctrl+V) the driver line copied to the clipboard in Step 2.
6. Delete the driver path information from the Device line.
Note:

⇒ The driver line, as copied from the config.sys file, is of the form “Device=driver path\driver name.sys /Switch Parameters.” The path information must be modified for your Recovery CD to be bootable. The Recovery Wizard requires that the driver line not include the driver path information. The resulting driver line should be of the form of “Device=driver name.sys /Switch parameters.” It is important to only delete the driver path information leaving the driver name and all /Switch parameters unmodified.

7. Hit the Enter key to exit the edit mode.
8. Click Next to continue to the next page.

Windows 95 Recovery Wizard - Select Backup Source
This page tells the Emergency Recovery Wizard where to find the device drivers to be added to the bootable Recovery CD/Diskette.

⇒ To complete this page:
1. Select the first device driver from the driver file list.
2. Click the Locate button to have the Recovery Wizard scan your system for the selected driver or Click the Browse button to find the button yourself.
3. Select the disk drive to search for your driver files and click the Locate Now button to begin the search.
4. Select the current driver from the search results list and click the Select button.
5. Repeat Steps 1 through 4 for all drivers listed in the driver file list.
6. Click Next to continue to the next page.

Windows 95 Recovery Wizard - Select Options
This page selects the options to be performed by the Emergency Recovery Wizard. By Default, the wizard automatically creates a bootable Recovery Diskette. You may choose to create a bootable Recovery CD and to store a drive image backup on that CD for recovery purposes. You will be required to supply a blank piece of CD-R or CD-RW media if you want to create a Recovery CD/backup.

⇒ To complete this page:
1. Check the desired options. By default, the wizard is configured to create an Emergency Recovery CD and save a drive image backup to the same disc.
2. Select the target CD-R/RW drive for the Recovery CD if necessary.
3. Insert a blank piece of CD-R/RW media in the selected drive.
4. Click Next to continue to the next page.

Note:

⇒ You may click on the “Erase” button if you want to erase the CD-RW media in the target drive.
Windows 95 Recovery Wizard - Select Backup Source
This page selects the drive to be backed up by the Emergency Recovery Wizard. Normally, this would be the drive with the operating system on it. This is the image that will be restored when you boot from your Emergency Recovery CD/Diskette. You may also specify a name for your backup image from this page.

To complete this page:
1. Select the drive to be backed up from the drive list. Only drives that are installed on your computer will be listed.
2. You may click the “Options…” button to change the compression settings or add password protection to your Recovery CD.
3. Enter a name for your backup image file. The boot files will be configured to restore the image with this name. It must comply with the DOS 8+3 file naming convention. In most cases, it is neither necessary nor recommended to change the default name.
4. Click Next to create the Recovery CD/Diskette.

Note:
⇔ If you used a Startup diskette on Page 1 of this wizard please remove the Startup diskette and insert a blank, formatted diskette if the floppy drive before continuing (clicking the Next button) with the Emergency Recovery Wizard.

Windows 95 Recovery Wizard - In Progress
This page displays the progress of each of the steps during the creation of the Recovery CD/Diskette.

To complete this page:
1. Click the View Report button to see the results of the backup operation or click Finish to exit the wizard.

Windows NT/2000 Recovery Wizard - Start Up Source
This page tells the Emergency Recovery Wizard where to find the files necessary to create a bootable recovery Diskette and CD. You will be required to supply a Windows 98 Startup diskette to use this feature.

To complete this page:
1. Select the floppy drive to be used to read the Windows 98 Startup Diskette. This drive will also be used to create the bootable Recovery Diskette.
2. Insert the Startup Diskette in to the selected drive.
3. Click Next to continue to the next page.

Notes:
⇔ Backup NOW! will read the systems files necessary to create a bootable Recovery Diskette before continuing on to the next page. These files are saved by Backup NOW! for later use.
⇔ This page may be bypassed if you have previously created a bootable Recovery CD/Diskette and answered “Yes” to the prompt to use the existing boot files.
Windows NT/2000 Recovery Wizard - Select Options
This page selects the options to be performed by the Emergency Recovery Wizard. By Default, the wizard automatically creates a bootable Recovery Diskette. You may choose to create a bootable Recovery CD and to store a drive image backup on that CD for recovery purposes. You will be required to supply a blank piece of CD-R or CD-RW media if you want to create a Recovery CD/backup.

To complete this page:
1. Check the desired options. By default, the wizard is configured to create an Emergency Recovery CD and save a drive image backup to the same disc.
2. Select the target CD-R/RW drive for the Recovery CD if necessary.
3. Insert a blank piece of CD-R/RW media in the selected drive.
4. Click Next to continue to the next page.

Note:
⇒ You may click on the “Erase” button if you want to erase the CD-RW media in the target drive.

Windows NT/2000 Recovery Wizard - Select Backup Source
This page selects the drive to be backed up by the Emergency Recovery Wizard. Normally, this would be the drive with the operating system on it. This is the image that will be restored when you boot from your Emergency Recovery CD/Diskette. You may also specify a name for your backup image from this page.

To complete this page:
1. Select the drive to be backed up from the drive list. Only drives that are installed on your computer will be listed.
2. You may click the “Options…” button to change the verification or compression settings or add password protection to your Recovery CD.
3. Enter a name for your backup image file. The boot files will be configured to restore the image with this name. It must comply with the DOS 8+3 file naming convention. In most cases, it is neither necessary nor recommended to change the default name.
4. Click Next to create the Recovery CD/Diskette.

Windows NT/2000 Recovery Wizard - Create Recovery Diskette
This page creates the Emergency Recovery Diskette.

To complete this page:
1. Select the floppy drive to be used to create the bootable Recovery Diskette.
2. Insert a blank, formatted Diskette in to the selected drive.
3. Click Next to create the Recovery Diskette and then continue to the next page.

Note:
⇒ Backup NOW! will prompt you should the diskette you provide is not blank. You may elect to overwrite the diskette at that time.
ADVANCED TOPICS

Windows NT/2000 Recovery Wizard - In Progress
This page displays the progress of each of the steps during the creation of the Recovery CD/Diskette.

To complete this page:
1. Click the View Report button to see the results of the backup operation or click Finish to exit the wizard.

Restoring your system with Silent Recovery

To restore from a Recovery CD or Recovery diskette:
1. If you are restoring from a Recovery CD, then you must do one of the following:
   - **For IDE Drives** – Set your CD-ROM drive to come first in the boot sequence (e.g. “CD-ROM, A, C”) in your BIOS settings.
   - **For SCSI Drives** – Select the “Enable bootable CD” option in the adapter settings, if your adapter supports it and set SCSI to come first in the boot sequence (e.g. “SCSI, A, C”) in your BIOS settings.
2. Insert the Recovery CD or Recovery diskette and CD then reboot your computer.
3. Your system should boot and begin the Silent Recovery program.
4. At the prompt, select the partition you wish to recover then hit Enter. In most cases, your system partition will be the first on the list.
5. Reboot your computer into Windows after the restore operation has completed.

Notes:

- Restored NTFS partitions cause the chkdsk utility to run when the system is rebooted to verify their proper operation. Windows NT/2000 will run the verification process and then restart. The restored drive should be operational once Windows has restarted.

- When executed from DOS to restore a File Level backup image, the RESTORE utility (RESTORE.EXE) will only restore files using the DOS 8.3 naming convention. Furthermore, for Windows NT/2000, the RESTORE utility will not be able to handle files in the NTFS format of Windows NT/2000. Therefore, it is not recommended that you attempt to recover your system from a File Level backup image. Use a Drive Image backup for recovery purposes whenever possible!

- In most cases, it is not possible to restore your system from a USB CD drive. This is because the USB device drivers are not loaded until Windows is loaded and running. You can create the Recovery CD on your USB CD-R or CD-RW recorder and then use any non-USB CD drive attached to your computer to restore your system from the Emergency Recovery CD.
Emergency Recovery with Windows 95/98/Me
A Recovery CD or Diskette is required to restore a lost or damaged system drive. The entire purpose of this disk is to get enough of the operating system back to allow you to access your CD drive so that you may restore your files after the damaged hard disk has been repaired or replaced. It requires that you have previously created a good backup of your operating system drive. In addition, it is important to realize that your new drive will be restored to the state that your system was in when you created the backup. Once in Windows you will need to use Backup NOW! to restore any additional files. Programs and data added after the creation of the backup cannot be recovered if they have not been backed up and must be re-installed. Frequent backups help to eliminate or minimize loss of your critical data in case of emergencies.

To backup and recover your Windows 95/98 operating system:
1. Create an Emergency Recovery CD as described above.
2. Create a Drive Image backup of your bootable drive partition.
3. Save the Emergency Recovery CD in a safe place. Regularly backup your important data and files, using Backup NOW!
4. When your hard disk fails to boot, after repairing or replacing the damaged disk drive or file system, follow the procedure above to restore your system to a bootable state.
5. Boot to your restored hard drive. Once in Windows, use Backup NOW! to restore any remaining files from a current backup(s).

Note:

The Recovery CD (or Diskette) boots to DOS only. At the command-line prompt, the RESTORE command will only restore files using the DOS 8.3 naming convention. Therefore, it is strongly recommended that you recover your system using a Drive Image backup file of your bootable drive. Once your bootable hard disk is restored and you can boot to Windows, run Backup NOW! in Windows, you can then restore from any File Level or Drive Image backup files to recover your important files and data.

Emergency Recovery with Windows NT/2000
Currently, you must have a Windows 98 Startup Diskette in order to make an Emergency Recovery CD (or diskette) for Windows NT (or 2000). If you have access to Windows 98, you can create a Startup Diskette in Window 98. That diskette is then used by Backup NOW! to create a Windows NT (or 2000) Emergency Recovery CD (or diskette). Note that Backup NOW! will ask for the Windows 98 Startup Diskette once and only once, it will store an image copy of the diskette for future use.

To backup and recover your Windows NT/2000 operating system:
1. Create an Emergency Recovery CD as described above.
2. Create a Drive Image backup of your Windows NT (or 2000) system drive using Backup NOW! It is recommended that you append this backup file on your Emergency Recovery CD.
3. Save the Emergency Recovery CD in a safe place. Regularly backup your important data and files, using Backup NOW!
4. When your hard disk fails to boot, after repairing or replacing the damaged disk drive or file system, follow the procedure above to restore your system to a bootable state.
5. Boot to your restored hard drive. Once in Windows, use Backup NOW! to restore any remaining files from a current backup(s).

**Note:**

The Recovery CD (or Diskette) boots to DOS only. At the command-line prompt, the RESTORE command will not be able to restore files in the NTFS format of Windows NT/2000. Therefore, you must use a Drive Image backup of your bootable partition to recover your system. Once your bootable partition is restored and you can boot to Windows, run Backup NOW! in Windows, you can then restore from any File Level or Drive Image backup files to recover your important files and data.

### Erasing a CD-RW Disc

You can erase your CD-RW media directly from the Backup NOW! Tools Menu. You can choose either a Quick Erase or Full Erase. The quick erase function overwrites the existing table of contents, thus reducing the time it takes to erase a CD-RW disc to just a few minutes. The full erase function erases all data on the disc and takes a considerably longer amount of time to complete. A full erase however restores the CD-RW media to a more reliable state.

**To erase a CD-RW disc:**

1. Select the Erase CD-RW disc item from the Tools Menu.

2. Select the CD-RW drive that contains the CD-RW media that you would like to erase from the CD-RW Drive list.

3. Select either Quick or Full for the Type of erase option. For reliability reasons, it is recommended that you choose the Full erase option.

4. Click Start to begin erasing.
Comparing Two File Folders

It is possible to compare the contents of two folders on your system using Backup NOW!’s Compare Files function. This utility is useful, for example, when you want to compare a backup copy to its original. Otherwise, this is a general tool for comparing the contents of similar directories.

To compare the contents of two folders:

1. Select the Compare Files… item from the Tools Menu.
2. Enter the locations of folders you wish to compare in each text field. If you don’t know the location of the folder, click on the browse button next to the text fields to search for the desired folders.
3. Click on OK.

The comparison result will show files that exist in one folder but not the other, files that are identical, and files that are different (i.e. “not compared”). The following is a sample output.

Setting Backup and Restore Options

You can control how Backup NOW! performs backup and restore operations.

To modify the Backup/Restore options:

1. Open the backup or restore options dialog.
2. Click on the appropriate tab for the options you wish to change.
3. Select the desired option settings. (See the information below for information on the available backup or restore options.)
4. Click OK to save your changes and close the selected options dialog box.

Note:
Clicking the Cancel button will close the options dialog box without saving your changes.
Backup Options
You can control how Backup NOW! will perform a backup operation from the Backup Options dialog.

To open the Backup Options dialog:

1. Select the Backup Options… item from the Options Menu of the Job Menu.

Note:
The Backup Options dialog is also accessible by clicking the Options… button from Step 3 “How” or from the Drive Image dialog during a backup operation. Only the General and Password tabs will be displayed for drive image backups.

General Tab
The General Tab contains settings to select the compression method for the backup file and provide a media label. You may also specify whether you want Backup NOW! to perform a comparison of the backed up file with the original when the backup file is created.

No data compression
Disabling data compression requires the least amount of time to complete the backup operation. It requires the most space on the destination disc since no compression is used.

Normal data compression
Normal data compression uses less space for the backup than no compression. It is also faster than using maximal compression.

Maximal data compression
Maximal data compression uses the least amount of disc space for the backup, but requires the most time.

Note:
The higher the compression rate, the slower the backup process!
Media

The options on the Media Tab are used to select if a previous backup file is to be overwritten with the current one or the current backup file will be appended to the destination disc. It only applies if you are using a CD-RW recorder with CD-RW media. In case of CD-R media, backup files are always appended to the end.

Append this backup to the media

This option will let you keep the previous backup file along with the one currently being created. The backup will be written in addition to the previous backup, without overwriting it.

Overwrite the media with this backup

This option will let you overwrite the previous backup file with the one currently being created. This is convenient for scheduled backups, which will use the same media for backup, without having to erase the media manually.

Prompt me for options

Selecting this option causes Backup NOW! to prompt you for either the append or overwrite option whenever you create your backup.

⇒ Note:

The three options you see only apply to the CD-RW media. For CD-R media, only “Append this backup to the media” can be used.
ADVANCED TOPICS

Type Tab
Options on the Type Tab select the type of backup you wish to perform.

All selected files
Create a complete backup of the selected files. The resulting backup file will always contain a copy of each file selected.

New and changed files only
Back up the new and changed files only, AFTER user has made a backup file with “All selected files” option.

Differential
Back up all the files that have been added or changed since the last complete backup was made using the “All selected files” option.

Incremental
Back up all the files that have been added or since the last backup operation.

Notes:

- You cannot perform differential or incremental backups without having created a baseline backup using the “All selected files” option.
- It is not recommended to mix differential and incremental backups methods.
Exclude Tab
The Exclude Tab specifies the types of files that you do not wish to back up. The file types can be either registered or custom.

To add specific file types to the backup exclude list:
1. Click the Add… button. The Add Exclude dialog box will be displayed.

2. Select the type (Registered or Custom) of file you wish to add.
3. If you selected Registered type, then select the registered file type you wish to exclude from the list.

   Or

   If you selected Custom type, then enter the file specification you wish to exclude from your future backups. You also need to specify the path to which this exclusion is to be applied.
ADVANCED TOPICS

θ Note:
For file specification, standard Windows file naming syntax applies, you can use wild cards (* and ?).

4. Click OK.
5. To add more to the list, simply repeat the process from Step 1.
6. Click OK from the Backup Options dialog to save the changes.

θ Note:
Adding a file type to the backup exclude list automatically prevents all files with that file specification from being included in future backup operations. The Windows Swap File (.SWP file in Windows 95/98, or PAGEFILE.SYS in Windows 2000/NT) is an example of a file type that it typically excluded during backup operations.

To remove specific file types from the backup exclude list:
1. Click on the Name(s) of, select, the file type(s) you wish to remove from the backup exclude list.
2. Click Remove.
3. Click OK from the Backup Options dialog to save the changes.

θ Note:
Removing a file type from the backup exclude list will allow that file type to be included in future backup operations. This is not automatic, files must be selected in the backup job to be included.

Report Tab
Options on the Report Tab determine the items included in the completion reports for all backup operations.

Report all files that were backed up
This option, when selected, will include information about every file backed up in the completion report for the current backup operation.
Password Tab

Options on the Password Tab determine if your backup files will be password protected.

Enable password protection

This option, when selected, will add password-protected encryption to the file level or drive image backup.

Password

Enter the password to be used for your backup file.

Reenter password

You must enter the desired password a second time for verification purposes.
ADVANCED TOPICS

Advanced Tab

Options on the Advanced Tab determine if the Windows registry file is included in the current backup operation.

Backup Windows Registry

When checked, this option causes Backup NOW! to include the Windows registry in the current backup operation.

Note:

The Windows registry file is normally located in the System folder of the Windows directory. If you backup the whole Windows directory, the Windows Registry is automatically backed up regardless whether this box is checked.

Restore Options

You can control how Backup NOW! will do a restore operation from the Restore Options dialog.

To open the Restore Options dialog:

1. Select the Restore Options… item from the Options Menu of the Job Menu.

Note:

The Restore Options dialog is also accessible by clicking the Options… button from Step 3 “How” during a restore operation.
**General Tab**
Options on the General Tab determine if a file on your computer should be replaced by the backup copy of that file.

Never replace a file with its backup copy
Files will not be replaced with their backup copy. Used when you want to keep your current copy in the hard drive.

Replace a file only if its backup copy has newer file date and time
Files are only replaced if the backup copies are newer than the current files in the hard drive.

Always replace a file with its backup copy
Files are always replaced with their backup copies whether or not the backup copy is newer or older.

**Report Tab**
Options on the Report Tab determine the items included in the completion reports for all restore operations.

Report all files that were restored
This option, when selected, will include information about every file restored on your computer in the completion report.
**ADVANCED TOPICS**

**Advanced Tab**
Options on the Advanced Tab determine if the Windows registry file is restored from the selected backup file.

![Restore Options](image)

Replace Windows Registry

When checked, this option causes Backup NOW! to restore the Windows Registry from the selected backup file. If the backup file does not contain the Windows Registry backup, no action is taken.

**Note:**

While it is important that you have a current backup of your Windows registry file, restoring the registry should only be done with extreme caution. The registry contains vital information about the operating system and the hardware and software installed on your computer. Restoring the registry will reset it to the point in time that the backup copy was created. If you have installed new software on your computer since that time, the operating system will no longer recognize it in most cases. You may need to re-install those programs to bring your registry up to date. For this reason, it is recommended that you *always* include the registry in your backups and *only restore it in extreme situations*!

If you do not have a good understanding of working with the registry file, it is recommended that you consult your local computer professional *BEFORE* modifying this critical system file!!

**Disc Info & Tools**

You may wish to check information about a disc before you decide to import any session from the CD-ROM disc. To do this, choose the Disc Info & Tools command under the Tools menu. The “Disc Info & Tools” dialog box will appear.

This box contains informational fields about the disc, including its Disc Type, Capacity, Free Space, Status, and other details as shown below:
Disc Type
The disc type can be one of the following: (1) CD-DA or CD-ROM disc; (2) CD-I disc; (3) CD-ROM XA disc.

Disc Status
Blank Disc: a blank CD-R disc.
Recordable Disc: not a blank disc but you can still use this disc to record. That means the disc has not been finalized yet.
Unrecordable Disc: either a conventional CD or Disc-At-Once CD-R disc. You cannot use this disc to record.

Re-Writable
This field indicates the total recordable capacity of the disc, as expressed in the “minutes: seconds: frames” format. If you insert a CD disc, this field will show you the exact capacity of the data stored on the disc.

Used Space
This field shows the amount of used space on the disc, as expressed in “minutes: seconds: frames” and megabytes (MB).

Free Space
This field shows the free and available space on the disc, as expressed in “minutes: seconds: frames” and megabytes (MB). If you insert a finalized or silver disc, this field will be zero, indicating no free space.

Buttons
Refresh: When you insert another CD, click this button to display updated information about the new CD. Or, when you want to make sure that the contents of the currently inserted disc are correctly displayed, click on the Refresh button.
ADVANCED TOPICS

Erase: The erase button will be enabled if the selected drive is a CD-RW device with CD-RW media. You can erase the CD-RW disc by clicking this button.

Close Session: If there are sessions that have remained open, when you highlight the open session, the Close Session button will be enabled. You can click it to close the selected session.

Close: Closes the Disc Info & Tools dialog when clicked.

CD Drive Properties
The Drive Properties dialog displays the read and write capabilities of the selected CD drive. You can also set the Backup Format for a drive using this dialog. The Drive Properties can be displayed by clicking on the CD Drive Properties… item on the Tools Menu or clicking the property sheet button to the right of the drive selection control.

Write Capabilities:
The write capabilities section indicate the supported write speed and indicates if the selected drive supports various features.

CD-R Speed – This drive writes to CD-R media at these speeds.

CD-RW Speed – This drive writes to CD-RW media at these speeds.

Burn Proof – This drive supports the Burn Proof technology.

CD Text – This drive will write the CD-Text information to the media.

Disc-At-Once – This drive supports the Disc-At-Once writing method.

Session-At-Once – This drive supports the Session-At-Once writing method.

Packet Writing – This drive supports packet-writing.

Write UPC & ISRC – This drive supports the writing of UPC and ISRC code information to the media.

Read Capabilities:
The read capabilities section indicate the supported write speed and indicates if the selected drive supports various features.

Max Speed – This drive will read at this speed.

Read CD-RW (Multi-read) – This drive supports multi-read for CD-RW media.

Backup Format:

Select the backup format to be used for backup jobs using this drive.

Format 1 – Use this format for a better backup and restore compatibility with a wider range of CD-Recorders.

Format 2 – Use this format for improved performance with backup operations. Try Format 1 should your encounter problems on this drive.

Backup Format

Backup Now! Version 2.0 supports a new format for backup files. Format 2 offers improved performance during backup and restore operations. This format is currently not available on all CD-Recorders. Backup Now! will test your drive and default to Format 2 whenever possible. Previous versions of Backup Now! only offered support for Format 1. You may still choose to use this format at any time from the Drive Properties dialog available from the Tools Menu. This setting does not effect restore operations. Backup Now! automatically senses the format type during restore operations and restores the selected data accordingly.

To set the Backup Format for a CD drive:

1. Select the CD Drive Properties… item from the Tools Menu.
2. Select the desired CD drive from the list.
3. Select the desired setting for the Backup Format.
4. Click OK to save the change.

Note:

You should try using Format 1 should you encounter errors while using Format 2.

Media Spanning

Media spanning is fully supported using Backup NOW!. Any backup file that exceeds the capacity of the existing media is split and carried over to the next CD. Extremely large backup files can be spanned across multiple CDs. Backup NOW! handles this automatically and prompts you when a media change is required for both backup and restore operations.

Choosing a Backup Method

This section describes how the incremental and differential backup methods work. It includes an example of using each type of backup and discusses the steps required to restore from both to illustrate the pros and cons of each method. It is up to you to decide which method to go with in your backup plan. Incremental backups require less space on your CD-R/CD-RW media but as you will see, can take significantly more work for restore operations. Differential backups are the opposite. If restore time is your main consideration then differential backups would likely be your best choice. If conserving space is the concern then incremental backups is the way to go. Remember that both backup types require a full backup as a baseline to produce a reliable backup of your data.
Example 1 – Incremental Backup & Restore
This example illustrates the “Incremental” backup method. As mentioned previously, incremental backups only include files added or modified since the last backup.

The following are in chronological order:

Day 0: There are two files in your backup set: MyFile1, and MyFile2. You make a File Level Backup with “All selected files” option. This “baseline” backup contains both MyFile1 and MyFile2.

You make changes to MyFile2 and add a new file, MyFile3.

Day 1: You make a “Incremental” backup. The backup file contains only MyFile2 and MyFile3—MyFile1 has not changed since the last backup so it is not included in the new backup.

You make changes to MyFile3 and add a new file, MyFile4.

Day 2: You make a “Incremental” backup. The backup file contains only MyFile3 and MyFile4—Neither MyFile1 nor MyFile2 has changed since the last backup so they are not included in the new backup.

You add a new file, MyFile5.

Day 3: You make a “Incremental” backup. The backup file contains only MyFile5—No other files have since the last backup so they are not included in the new backup.

Example 2 – Differential Backup and Restore
The differential backup method includes all files that have been changed or added since the last full backup.

The following are in chronological order:

Day 0: There are two files in your backup set: MyFile1, and MyFile2. You make a File Level Backup with “All selected files” option. This “baseline” backup contains both MyFile1 and MyFile2.

You make changes to MyFile2 and add a new file, MyFile3.

Day 1: You make a “Differential” backup. The backup file contains only MyFile2 and MyFile3—MyFile1 has not changed since the last baseline backup so it is not included in the new backup file.

You make changes to MyFile3 and add a new file, MyFile4.

Day 2: You make a “Differential” backup. The backup file contains MyFile2, MyFile3 and MyFile4—MyFile1 has not changed since the last baseline backup.

You add a new file, MyFile5.

Day 3: You make a “Differential” backup. The backup file contains MyFile2, MyFile3, MyFile4 and MyFile5—MyFile1 still has not changed since the last baseline backup.
**Which backup method is best for me?**

As you can see, the backup files created using the differential backup method will be larger as the number of days from the last baseline backup increases. The more files added or changed the more files that are recorded in each new differential backup. Incremental backups are smaller as demonstrated in the examples above.

However, what about restoring from each of these backup types? Well, to fully restore all five of these files using the incremental backup method, you would first restore the baseline backup. Once the baseline backup has been fully restored, you must restore each subsequent incremental backup. This ensures that you will now have all new files as well as the latest version of each file that has been modified since the last baseline backup was created. You can quickly see that as the numbers of days from the last baseline backup increases, the number of restore operations required to recover all your files also increases. The amount of work to recover your data is a function of the number of incremental backups since the last baseline backup.

Now what about restoring files backed up using the differential backup method? A quick look at the backup created on Day 3 shows that it contains all of the new files added since the baseline backup. It also contains the latest version of any file that has been modified since the last baseline backup. We can see that the restore process can be completed in two restore operations: restore all files from the last baseline backup and the latest differential backup file, regardless of how many differential backups have occurred since the last baseline backup. Again, as you can see, differential backups are larger but recovery can always be completed in two restore operations.

There is one last consideration: unattended backups. You can easily setup and schedule the daily backups from our examples using Backup NOW! and the Backup NOW! Scheduler. Backup NOW!’s media spanning feature will automatically span your backup images across multiple CDs but somebody needs to change CDs should spanning actually occur. There are two things to consider about media spanning. First, large backup files can trigger spanning. Any file that would exceed the available capacity of the current CD will be spanned to another CD. Since differential backups tend to be much larger, the spanning issue is more likely to occur when using the differential backup method.

The second consideration is the “Append this backup to the media” option found on the Media tab of the Backup Options settings. This option allows you to write more than one backup file to a CD, thereby saving media costs. Multiple backups saved to the same media increase the chance that media spanning will be required. If you select this option and are running unattended backups care must be taken to monitor the amount of available space on the CD after each backup. Even incremental backups will eventually trigger the media spanning feature after enough backups have been performed.

As this discussion illustrates, choosing which backup method will depend on many factors. The quantity of data to be backed up, rate of changes made to existing files, rate of file additions to your system, unattended backup and the frequency of backups in your backup plan all must be evaluated before choosing the backup method that best works for you. Every situation is different but understanding these factors will help you make the best choice for your environment.
Error Messages

The Log File
NTI Backup NOW! will create log files (or completion reports) that allow you to trace and diagnose problems that can occur during backup, restore, or compare operations. Please refer to the “Completion Reports” section on Chapter 4.

Error Messages

General Errors

Error: Failed to open file.
Analysis: The backup image file (.nbf or .npf file) cannot be opened for reading. The file may have been damaged or incorrectly created.
Solution: Use good brand-name media discs, as this error is often associated with bad media. If you use a CD-RW disc that has been written many times, we recommend that you do a full erase before using it again for backup.

Error: Files not compared.
Analysis: The backup copy stored in the backup image does not compare with its original file.
Solution: The file has been modified since backup. This happens often to active system files or temporary files. Such cases are normal and no errors have occurred.

Error: Insufficient Disk Space for restore
Analysis: There is not enough space in the target drive (partition) to restore the selected files or drive image.
Solution: Choose a target drive with sufficient space.

Error: Failed to prepare registry files for backup
Analysis: Failed to access the registry due to user permission restrictions (in Windows 2000 and NT), or registry files are damaged.
Solution: In Windows 2000 and NT, you must log on as a member of the Administrator’s group to be able to access the Registry.
Error: Backup completed with skipped file(s).

Analysis: Failed to open or read certain file(s), which is (are) skipped.

Solution: Check your access rights to these files. Make sure these files are not in use or locked by other applications or users. In Windows 2000 and NT, we recommend that you log on as Administrator.

Error: Restore completed with skipped file(s).

Analysis: Failed to restore certain file(s) due to access restrictions.

Solution: Check your access rights to these files. Make sure these files are not in use or locked by other applications or users. In Windows 2000 and NT, we recommend that you log on as Administrator.

Error: Invalid Drive Image backup file

Analysis: The drive image backup file on disc is either incorrectly created or damaged.

Solution: Retry the backup to create a good drive image backup file. We recommend that you use good name-brand media, especially for CD-RW.

Error: Data compression (or decompression) error.

Analysis: Failed to read the compressed file on backup image file. The file may have been damaged.

Solution: Retry the backup to create a good backup image file. We recommend that you use good name-brand media, especially for CD-RW.

ASPI Manager Errors

Error: An incompatible ASPI Manager is installed.

Analysis: The SCSI card and ASPI Manager are not supported by NTI Backup NOW!.

Solution: Make sure the ASPI Manager and SCSI card are supported by NTI Backup NOW!. Please refer to the System Requirements in Chapter 1 in this manual.

Error: No ASPI managers were found!

Analysis: The ASPI device driver was not installed before you ran the program.

Solution: Install the ASPI Manager. For instruction of how to install, please refer the documents provided by the SCSI card manufacturer.

Error: ASPI for Windows failed to initialize.

Analysis: ASPI for Windows did not properly load/initialize in memory. This may be caused by a lack of system resources and/or mismatched ASPI file version(s).

Solution: Make sure the CD Recorder is connected to the PC and the power is on. Exit Windows and reboot the system. Then try it again. You may be required to re-install the ASPI device driver files if this error is a recurring problem.
ADVANCED TOPICS

CD-ROM Drive & CD Recorder Errors

Error: No supported CD Recorder found

Analysis: Either your CD-R/RW drive is not yet supported by your current version of NTI Backup NOW!, or your drive is not installed correctly.

Solution: Check NTI web site www.ntius.com for drive support information. Make sure your drive is properly installed and connected.

Memory & Hard Disk Space Errors

Error: Out of memory.

Analysis: There is not enough memory.

Solution: Close other applications and try again. If it still can not be solved, reboot your system, and try again.

Error: Fatal memory lost.

Analysis: This is a memory management error.

Solution: Close all the applications, reboot your system, and try again.

Window’s Errors

Error: Cannot set timer.

Analysis: Unable to set the timer which is a Window’s resource. Close other applications and try again.
Making Backup NOW! Work for You!
Chapter 5 — Topics of discussion

Making Backup NOW! Work for You

Preparing for that rainy day!

Digital Dan’s Backup NOW! Recommendations
  #1 – Consider the media type and quality
  #2 – Test and verify your backup solution
  #3 – Create an Emergency Recovery CD/Diskette
  #4 – Backup the system drive to your Recovery CD
  #5 – Design your backup plan
      Factors to consider
      Incremental vs. Differential Backups
  #6 – Make it Happen!
Getting the most out of Backup NOW!

So now, you have learned how to use Backup NOW! and are wondering what you do next. In this chapter, we will provide suggestions on getting the most from your Backup NOW! software. We will start out by making an Emergency Recovery CD complete with a drive image backup of your system drive. That sill provide you failsafe configuration should you ever find yourself faced with the kinds of system problems that prevent you from booting your system.

After that, we will review the different backup methods and suggest a backup plan using Backup NOW! As always, these are just suggestions and you may want to alter them or create your own backup plan based on your specific needs.

Preparing for that rainy day!

While we all know it could happen we talk ourselves into believing that it will never happen to us. Don’t you just know it…it happened! Our system crashes, or we caught the latest “nasty” little virus running around the web, and we cannot boot our computer. What happens next is determined by s few simple decisions we made long ago. Did you create an Emergency Recovery CD? Did you develop a backup plan as a safety net? Did you follow that plan?

If you answered “No!” to any of the above you may find yourself facing many long frustrating hours of recovering your PC. You may need to go out and hire your local “guru” to get you back on and “surfing the net.” In addition, it is very likely that you have lost some of your important data forever!

Backup NOW! brings you a step closer to avoiding the above “nightmare.” Combined with your CD-R/CD-RW recorder, Backup NOW! can save the day! Of course, it takes a little help from you but we can do it together. Remember, Digital Dan says, “Don’t be a fool, Backup is cool!” It only takes one encounter with the situation above to realize that he hit it right on the nose!

Digital Dan’s Backup NOW! Recommendations:

The following are Digital Dan’s recommendations for getting the most from Backup NOW!

Recommendation #1 – Consider the media quality and type

Your first choice is “Do I use CD-R or CD-RW for my backups?” There are a few important things to remember before you make this choice. First, CD-R media is more stable and in that sense, more reliable than the newer technology found in CD-RW media. It is also faster meaning that you can reliably record at a higher speed than is available on a CD-RW disc. Currently, CD-R technology enjoys a 3 to 1 advantage in this area. Therefore, if the amount of data or time available to perform a backup is a factor you may want to use CD-R media instead.

The second consideration is one of quality. You may find that different media performs differently on your drive and from drive to drive. It is highly recommended that you do not exchange media quality when it comes to backing up your important data!
Recommendation #2 – Test and verify your backup solution
The bottom line is simply this…make sure it works before you trust that your data is safe. This is your responsibility to yourself and your valuable data. Once you have developed your backup plan then test it…including as many recovery scenarios as possible. If you think of it now and verify that your solution works then you will be in much better shape should it ever occur. In the best of cases, you will never need your backup data but it is much better to know it is there and that it works! And always remember Recommendation #1 above…the media matters, in both type and quality. You may want to experiment with both CD-R and CD-RW media as well as different brands during your testing process. Your drive and the media you select become a part of your backup team and unfortunately, not all players get along with each other.

Recommendation #3 – Create an Emergency Recovery CD/Diskette
As discussed in previous chapters, an Emergency Recovery CD/Diskette contains enough of the operating system to allow you to boot your computer into DOS. It also contains various diagnostic and repair tools for your system and disk drives. Finally, it contains the drivers required to access your CD drive and restore your system from a previously created backup.

We also discussed that you may need to use a Recovery Diskette instead of a CD if your systems' BIOS does not support booting directly from a CD-ROM drive. It really doesn’t change the plan much but you will need to boot from the Recovery Diskette and then use the Backup NOW! Restore command to recover your system drive. Either way, Backup NOW! is the answer.

For step-by-step instructions to create a Recovery CD/Diskette, see “Emergency Recovery Diskette and CD” on Page 28 of this guide.

Recommendation #4 – Backup your system drive to your Recovery CD
This recommendation is just Step Two of creating a Recovery CD but it does not have to be saved on a Recovery CD. The important part here is that you have a good, drive image backup of the drive that contains your operating system files. In most cases, your system drive will be your C drive but that is certainly not a requirement.

This backup image can be copied to your system drive using the NTI restore utility included on your Recovery CD/Diskette. In many cases, your system drive had changed considerably from the time you made this drive image. The main purpose here is to restore enough of the operating system to run Windows again. Once you reboot into Windows, run backup now and restore your system using the latest backups as created by your backup plan.

For systems that cannot boot from a CD-ROM drive, you will need to create this backup on a CD and keep it with your Recovery Diskette. If you can boot from a CD drive, simply append the drive image backup to the Recovery CD created above. Label it accordingly and keep it in a safe place for that rainy day…just in case it DOES happen to YOU!

For step-by-step instructions to create a drive image backup, see “Creating a Drive Image Backup” on Page 16 of this guide.

Recommendation #5 – Design your backup plan
This recommendation is more of a guide really and is not to be taken as the only way to use Backup NOW! for backing up your critical programs and data. In fact, it is a pair of basic plans, one using incremental backups and the second using differential backups to accomplish the task of backing up your data. As discussed in Chapter 4, there are many factors to consider when developing your own plan. We’ll recap a few of them here and then present each plan. It is up to you to decide which plan will work for you. You will probably discover that your plan will be different than either of the samples provided here.
Factors to consider in your backup plan

As you will quickly discover, there is no one “RIGHT” way to design your backup plan. The factors listed here are just a few and not intended to be an exhaustive list of things to consider. You will also see that they all are interrelated. If you choose this option, it will likely impact you in some other place. What you are looking for is the “best fit” for your computing environment.

- **What types of data should be backed up?**

  This question wants you to begin to think about the big picture. Any backup takes time and space. There is an associated cost in terms of both time and money to backup your system’s data. There is also a cost for losing that data should your system not be able to access it. Everything has a price and it is up to you to make a decision about what is and isn’t important to backup.

  In general, remember this! Most everything can be replaced. Program files can be re-installed and even the computer itself can be replaced. The most difficult thing to replace is user data. Your data files of your home finances, any business records that you may have, tax information, letters that you write and the pictures and recipes are examples of user data you may have on your computer. Data is the most difficult to recover if it is not backed up. In some cases, it may never be replaced or replaced at considerable cost to you. It is time to start thinking about what data you have on your computer.

- **What data will be backed up?**

  Well, have you identified the critical items that you need to backup? Just remember that selecting too much data for a backup has a cost but failing to backup irreplaceable data may cost even more. If you feel that the amount of data you wish to backup is too large, remember, programs, drivers and other operating files can be recovered by reinstalling them from their original media in many cases. User data usually can only be replaced manually if at all.

- **How often is this data modified?**

  This information can help you decide which backup method to use as well as how frequently you will want to schedule your backup jobs. It is also important to think in terms of maximum exposure when deciding on your backup job schedule. How much data can be lost between backups? What will it cost, in terms of time, money or both, to manually re-enter or recover the data if your system goes down and you cannot access your data? Can it be recovered manually? If not, then what?

  While most of these issues are more clearly defined in a business environment, home users must face them too, especially if you work out of your home or use your computer for your home based business!

- **How much data is being backed up?**

  The amount of data being backed up is important when you consider the backup method for your plan. Will you use compression with your backup jobs? Will I need to schedule my backup jobs to run late at night when nobody is around to monitor the process? Generally, the more data the more time it will take to restore. Data compression reduces the space requirements of the resulting backup image but usually at the expense of time. As mentioned in Chapter 4, media spanning can be an issue when you schedule an unattended backup. Backup NOW! will automatically span a backup image to another disc should the first disc become full. A backup job may be left suspended, waiting for a new disc to be inserted, should this occur.
Making Backup NOW! WORK FOR YOU!

Incremental vs. differential backups

The differences between these backup methods and their pros and cons have been discussed in detail in previous chapters. Rather than to rehash them, we will include a sample backup plan for each method.

For more information, see “Choosing a Backup Method” on Page 51 of this guide.

When we refer to “selected files,” it is understood that you will decide which files are important to include in your backup plan. In addition, both backup methods require that a baseline backup of all selected files be performed before the periodic incremental or differential backups. You will also notice that we schedule the baseline backup job to occur on a periodic basis. This helps to minimize the size of the backup images and in some cases, the time to restore your files when necessary.

Both plans use the same frequency for each type of backup job. The baseline backup will be run monthly and the incremental or differential backups will run daily. Again, you can modify the job schedule to meet your individual backup requirements.

Digital Dan’s Incremental Backup Plan:

1. Create and save a baseline backup job of all selected files. Name it `baseline.bjf` and save it using the Save command from the Job Menu. (See “Creating a Backup Job” on Page 13 of this guide for detailed instructions.)

2. Run this backup job to create the required baseline backup of the selected files. (See “Creating a Backup Job” on Page 13 of this guide for detailed instructions.)

3. Schedule the baseline backup job to run monthly, starting one month from now, at midnight. (See “Using the Scheduler” on Page 21 of this guide for detailed instructions.)

4. Open the baseline job file (.bjf). Change the backup type to incremental from the Type tab of the backup options dialog. Save this job as `daily.bjf` using the Save As command on the Job Menu. (See “Creating a Backup Job” on Page 13 and “Backup Options” on Page 40 of this guide for detailed instructions.)

5. Schedule the incremental backup job `daily.bjf` to run daily, starting one day from now, at 2:00 AM. (See “Using the Scheduler” on Page 21 of this guide for detailed instructions.)

Note:

The possibility exists that both backup jobs will run on one morning of every month. The baseline job is scheduled to run first and will backup all selected files on that date. The daily job runs second but will have very few, if any, files to backup and so it executes and exits quickly.
Digital Dan’s Differential Backup Plan

1. Create and save a baseline backup job of all selected files. Name it `baseline.bjf` and save it using the Save command from the Job Menu. (See “Creating a Backup Job” on Page 13 of this guide for detailed instructions.)

2. Run this backup job to create the required baseline backup of the selected files. (See “Creating a Backup Job” on Page 13 of this guide for detailed instructions.)

3. Schedule the baseline backup job to run monthly, starting one month from now, at midnight. (See “Using the Scheduler” on Page 21 of this guide for detailed instructions.)

4. Open the baseline job file (.bjf). Change the backup type to differential from the Type tab of the backup options dialog. Save this job as `daily.bjf` using the Save As command on the Job Menu. (See “Creating a Backup Job” on Page 13 and “Backup Options” on Page 40 of this guide for detailed instructions.)

5. Schedule the differential backup job `daily.bjf` to run daily, starting one day from now, at 2:00 AM. (See “Using the Scheduler” on Page 21 of this guide for detailed instructions.)

Note:
The possibility exists that both backup jobs will run on one morning of every month. The baseline job is scheduled to run first and will backup all selected files on that date. The daily job runs second but will have very few, if any, files to backup and so it executes and exits quickly.

Recommendation #6 – Make it Happen!
Digital Dan’s final words of advice — Make it happen! Regardless of your backup needs, you’ll find Backup NOW! an invaluable tool to do just that. Make it happen! We’ve designed Backup NOW! from start to finish to make it both feature-rich and easy-to-use.

The rest is up to you!
Chapter 6

Backup NOW! Command Reference
Chapter 6 — Topics of discussion

Backup NOW! Command Reference

Menu Bars
  Job Menu
  Edit Menu
  View Menu
  Tools Menu
  Help Menu
  Quick Command Menus

Toolbar

Status Bar
Backup NOW! Menus

All NTI Backup NOW! menus can be invoked by a single left-button click of a mouse on the menu title. Menu items are aligned on the left, with keystroke shortcuts (if applicable) displayed on the corresponding right side. The underlined character of a menu item, if pressed (through the keyboard), will have the same effect as if the menu item were selected with the mouse.

### Job Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open…</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save As…</td>
<td></td>
</tr>
<tr>
<td>Options</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>1 H:\My Documents\Mysys BJF</td>
<td></td>
</tr>
<tr>
<td>2 H:\My Documents\Untitled BJF</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

**New**

Creates a new backup job file.

**Open…**

Opens an existing backup job file.

**Save**

Saves the current backup job file (.bjf) on your computer.

**Save As…**

Saves the current backup job file (.bjf) with a specific name or path.

**Options**

**Backup Options…**

Allows you to set the backup options for this backup operation.

**Restore Options…**

Allows you to set the restore options for this restore operation.

**Recent File**

Displays the most recently used image files.

**Exit**

Exits the Backup NOW! program.
Edit Menu

Select
Checks all the check boxes of the highlighted item.

Deselect
Unchecks all the check boxes of the highlighted item.

Find Files…
Brings up the Find Files dialog box, which will let you search for a file within the current backup volume to restore. (This option is available only in Restore mode.)

View Menu

Toolbar
Hides or displays the main toolbar. When checked, the toolbar is displayed below the Backup NOW! menu bar.

Status Bar
Hides or views the Status Bar. When checked the status bar is displayed on the bottom of the Backup NOW! program window.

Backup
Switches Backup NOW! in to backup mode.

Restore
Switches Backup NOW! in to restore mode.

Compare
Switches Backup NOW! in to compare mode.

Refresh
Refreshes the current view.
Tools Menu

- **View Reports**
  - View Backup Reports...
  - View Restore Reports...

- **Recovery Diskette & CD**
  - Creates a recovery diskette and/or CD for emergency rescue.

- **Compare Files**
  - Compares the contents of directories.

- **Erase CD-RW Disc**
  - Erases the contents of a CD-RW disc.

- **Disc Info & Tools**
  - Displays various information about the media in the selected drive.

- **CD Drive Properties**
  - Displays the capabilities of any CD drive installed on your system.

- **Drive Image Backup/Restore**
  - Allows you to backup or restore a drive image.
Help Menu

<table>
<thead>
<tr>
<th>Help Topics</th>
<th>NTI Home Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register my NTI software</td>
<td>Backup NOW! Home Page</td>
</tr>
<tr>
<td>NTI Help Topics</td>
<td>Frequently Asked Questions on the web</td>
</tr>
<tr>
<td>Software Update Download Page</td>
<td>Software Update Download Page</td>
</tr>
<tr>
<td>Other Internet Pages</td>
<td>Other Internet Pages</td>
</tr>
</tbody>
</table>

Help topics
Displays the Backup NOW! online help system.

Register my NTI software
Links you to our online registration page @ www.ntius.com/register.cfm.

NTI Home Page
Links you to our home page @ www.ntius.com.

Backup NOW! Home Page
Links you to the Backup NOW! home page @ www.ntibackupnow.com.

Frequently Asked Questions on the web
Links you to our FAQ page @ www.ntius.com/faqs.htm.

Software Update Download Page
Links you to our software download page @ www.ntius.com/download.htm.

Technical Support Page
Links you to our technical support page @ www.ntius.com/support.htm.

Other Internet Pages

CD Page

About Backup NOW!
Displays version and program information about Backup NOW!
Quick Command Menus
The Quick Command menu gives you easy access to commonly used commands in Backup NOW!. The command list changes depending on the current mode. To access the quick command menu simply right click in the selection area of the screen.

Backup mode quick command menu

Select
Checks all the check boxes of the highlighted item.

Deselect
Unchecks all the check boxes of the highlighted item.

Restore and Compare mode quick command menu

Select
Checks all the check boxes of the highlighted item.

Deselect
Unchecks all the check boxes of the highlighted item.

Find Files…
Brings up the Find Files dialog box, which will let you search for a file within the current backup volume to restore. (This option is only enabled in Restore mode.)

Toolbar
This section describes the Toolbar in Backup NOW!.

Toolbar buttons are used as shorthand for menu commands. Each toolbar button represents a frequently used command. The display of these buttons is context-sensitive in that only buttons relevant to the current context are shown and enabled.

The following is a run-down of the Toolbar buttons and their respective menu commands.
### Hiding the Toolbar

To Hide the Toolbar:

1. Click the Toolbar item from the View Menu. You should no longer see a small check mark to the left of the Toolbar item and the Toolbar should now be invisible.

### Viewing the Toolbar

To Display the Toolbar:

1. Click the Toolbar item from the View Menu. You should see a small check mark to the left of the Toolbar item and the Toolbar should now be displayed at the top of the main program window.

### Status Bar

For help, press F1

### Hiding the Status Bar

To Hide the Status Bar:

1. Click the Status Bar item from the View Menu. You should no longer see a small check mark to the left of the Status Bar item and the Status Bar should now be invisible.

### Viewing the Status Bar

To Display the Status Bar:

1. Click the Status Bar item from the View Menu. You should see a small check mark to the left of the Status Bar item and the Status Bar should now be displayed at the bottom of the main program window.
Glossary

Baseline Backup
A baseline or all files backup is a full file level backup of the selected data. It serves as a reference point for both incremental and differential backups. They can be scheduled periodically to reduce the number of restorations required for incremental backups or the space requirements of differential backups.

Differential Backup
Differential backups record all changes made since the last baseline backup. Any files that have been added or modified since the last baseline backup are included in a differential backup. This results in an increased space requirement for the resulting backup file. Restoring from a differential backup requires only that you restore the baseline backup file and then the latest differential backup.

Drive Image Backup
Drive Image backups are called that because they are exact duplicates of a physical disk drive on your machine. Unlike file level backups, drive images bypass the file system and communicate directly with the physical disk drive. Drive image backups cannot be scheduled using Backup NOW! Scheduler. They can be written to either a CD-R/CD-RW disc or another storage device. The best way to think of them is as clones. All data is replicated exactly as it exists on the drive being backed up.

File Level Backup
File level backups are called that because they backup and restore your data by communication with your computer’s file system. All reading and writing of data is passed over to the file system. File level backups can be saved and scheduled to run at a preset time. Any data that your files system has access to, such as local or network drives can be backed up or restored through File Level backups.

Incremental Backup
Incremental backups record all changes made since the last backup. Only files that have been added or modified since the last backup are included in an incremental backup. This results in a reduced space requirement as saves media. Restoring from an incremental backup requires that you restore the baseline backup file and then each subsequent incremental backup, in order, until you get to the desired target date.

Media Spanning
The ability to continue a backup or restore operation over multiple CDs. Spanning removes the limitations that the media capacity would otherwise place on the size of a single backup or restore operation.

Recovery CD
A Recovery CD is a copy of the Recovery Diskette on a CD. When combined with a drive image backup of the operating system drive, it can be used to restore your system drive. It is used when your system’s BIOS supports booting from a CD device.

Recovery Diskette
A Recovery Diskette is a modified version of the Startup Diskette. In addition to the files included by the operating system, it contains NTI’s restore.exe program. It is used when your system’s BIOS does not support booting from a CD device.

Startup Diskette
A Startup Diskette is a bootable diskette that is created by the Windows operating system. It can be used to boot your system to DOS and run some basic troubleshooting tools when you can not boot from your system hard drive.
Index

A
About Backup NOW! ............................. 3

B
Backup Format ..................................... 51
Backup NOW!
  Menus ............................................. 67
  Edit Menu ....................................... 68
  Help Menu ..................................... 70
  Job Menu ....................................... 67
  Quick Command Menus ....................... 71
  Tools Menu ..................................... 69
  View Menu ..................................... 68
  Toolbar .......................................... 71
Backup NOW! Scheduler ....................... 21
  Job Logs ....................................... 22
  Menus .......................................... 23
  Advanced Menu ................................. 23
  Help Menu ..................................... 23
  Program Menu ................................ 23
Backup Options .................................... 40
  Advanced Tab ................................ 46
  Exclude Tab .................................. 43
  General Tab .................................. 40
  Media Tab ..................................... 41
  Password Tab ................................ 45
  Report Tab .................................... 44
  Type Tab ....................................... 42
Baseline Backup ................................... 73
  Buttons ........................................ 50
  Close .......................................... 50
  Close Session ................................. 50
  Erase .......................................... 50
  Refresh ...................................... 49

C
CD Drive Properties ............................. 50
Choosing a Backup Method ..................... 51
Company or Product News ....................... 7
Comparing Two File Folders .................... 39
Completion Reports ............................. 27
  Backup ....................................... 27
  Restore ...................................... 28

D
Differential Backup ................................. 52, 73
Disc Info & Tools .................................. 48
  Buttons ........................................ 49
  Disc Status ................................... 49
  Disc Type ..................................... 49
  Free Space .................................... 49
  Re-Writable .................................... 49
  Used Space .................................... 49
Drive Image Backup ............................... 4, 73
  Backup ....................................... 16
  Restore ....................................... 17

E
Emergency Recovery .............................. 28
  Starting the Wizard ........................... 29
  Windows 95/98/Me ......................... 37
  Windows NT/2000 .......................... 37
Erasing a CD-RW Disc ............................ 38
Error Messages .................................... 54
  ASPI Manager Errors ....................... 55
  CD-ROM Drive & CD Recorder Errors ..... 56
  Memory & Hard Disk Space Errors ..... 56
  The Log File ................................. 54
  Window’s Errors ............................. 56

F
File Level Backup .................................... 4, 73
  Backup ....................................... 13
  Compare ....................................... 15
  Restore ....................................... 14
  Restore with Find Files .................... 14
  Frequently Asked Questions (FAQs) ........ 7

G
Getting Started .................................... 11
Getting the most out of Backup NOW! ........ 59
Glossary ......................................... 73

Contacting Technical Support .................... 8

75  Glossary
INDEX

H
Hiding the Status Bar .........................72
Hiding the Toolbar ..............................72

I
Incremental Backup ............................52, 73
Installation ...........................................6

M
Media Spanning ....................................51, 73
My Catalog .............................................12

R
Recovery CD ..........................................73
Recovery Diskette .................................73
Removing Backup NOW! .......................7
Restore Options .................................46
Advanced Tab ....................................48
General Tab ......................................47
Report Tab ......................................47
Restoring your system with Silent Recovery 36

S
Scheduling a Backup Job ......................21
Startup Diskette .................................73
System Requirements ..........................5

T
Tools & Utilities ....................................27

U
Updates & Upgrades .............................7

V
Viewing the Status Bar ..........................72
Viewing the Toolbar .............................72

W
Web Resources ......................................7
Windows 95 Recovery Wizard
Page 1 – Start Up Source .......................32
Page 2 – Driver Configuration ..................32
Page 3 – Select Backup Source ...............33
Page 4 – Select Options .........................33
Page 5 – Select Backup Source ...............34
Page 6 – In Progress .............................34
Windows 98/Me Recovery Wizard
Page 1 – Start Up Source .......................30
Page 2 – Select Options .........................31
Page 3 – Select Backup Source ...............31
Page 4 – In Progress .............................32
Windows NT/2000 Recovery Wizard
Page 1 – Start Up Source .......................34
Page 2 – Select Options .........................35
Page 3 – Select Backup Source ...............35
Page 4 – Create Recovery Diskette ..........35
Page 5 – In Progress .............................36